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باحث في فقه الأمن السيبراني الأسري، ومتخصص في الأمن السيبراني
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مقدمة في تحليل الشبكات

infoتعريف تحليل الشبكاتsecurityالأهمية في الأمن السيبراني

buildتطبيقات عمليةappsأدوات التحليل الشائعة

عملية فحص ومراقبة حركة البيانات •

تحليل تدفق المعلومات بين الأجهزة •

تشخيص المشاكل وتحديد الأداء •

فهم سلوك الشبكة وتفاعلها •

كشف التهديدات والهجمات المحتملة •

مراقبة الأنشطة المشبوهة •

تحديد نقاط الضعف في الشبكة •

توفير أدلة للتحقيق في الحوادث •

استكشاف الأخطاء وإصلاحها •

تحسين أداء الشبكة •

تحليل سلوك التطبيقات •

مراقبة استخدام النطاق الترددي •

تدريب وتعليم مفاهيم الشبكات •

Wireshark - تحليل الحزم الشامل •

Tcpdump - أداة سطر الأوامر •

Nmap - مسح الشبكة واكتشاف الأجهزة •

PRTG - مراقبة الشبكة •

NetFlow - تحليل تدفق البيانات •



عد أداة استخباراتية؟ ما هي Wireshark؟ ولماذا تُ

infoWireshark تعريفanalyticsفي تحليل البيانات Wireshark قدرات

securityالاستخدام كأداة استخباراتيةfind_in_pageأمثلة على المعلومات المستخلصة

محلل بروتوكولات الشبكة مفتوح المصدر •

أداة لالتقاط وتفحص حزم البيانات •

يدعم مئات البروتوكولات المختلفة •

متوافق مع أنظمة التشغيل المختلفة •

واجهة رسومية سهلة الاستخدام •

التقاط المباشر لحركة البيانات •

عرض تفصيلي لطبقات الشبكة المختلفة •

تحليل البروتوكولات المعقدة •

إمكانية فلترة وتصنيف الحزم •

إعادة بناء الجلسات والتدفقات •

كشف الأنشطة المشبوهة في الشبكة •

تحليل سلوك التطبيقات والبرمجيات •

مراقبة الاتصالات غير المصرح بها •

تحديد أنماط الهجمات السيبرانية •

تجميع الأدلة الرقمية للتحقيقات •

بيانات الاعتماد والمصادقة •

محتوى الرسائل والمحادثات •

عناوين IP والمنافذ المستخدمة •

الملفات المنقولة عبر الشبكة •

سجل التصفح والأنشطة الإلكترونية •



Wireshark التطور التاريخي لأداة

historyWireshark (Ethereal) بداياتtrending_upالتطورات الرئيسية عبر الزمن

starالإصدارات المهمة ومميزاتهاupdateاليوم Wireshark

1998 بواسطة جيرالد كومبس تطويره في  •

Ethereal اسمه الأصلي •

بدأ كأداة بسيطة لتحليل الشبكات •

دعم أساسي للبروتوكولات الشائعة •

واجهة رسومية بدائية •

2006 تغيير الاسم إلى Wireshark بسبب مشاكل العلامة

التجارية
•

إضافة دعم لمئات البروتوكولات الجديدة •

تحسينات في أداء التقاط الحزم •

تطوير قدرات التشفير وفك التشفير •

تحسين واجهة المستخدم وإضافة الميزات المتقدمة •

Wireshark 1.0 أول إصدار مستقر تحت اسم •

واجهة مستخدم محدثة بالكامل 2.0 •

3.0 دعم أفضل للتشفير والبروتوكولات الحديثة •

4.0 تحسينات كبيرة في الأداء والاستقرار •

4.4 إصلاحات أمنية وتحديثات البروتوكولات •

أداة قياسية في تحليل الشبكات •

يدعم آلاف البروتوكولات المختلفة •

مجتمع نشط من المطورين والمساهمين •

استخدام واسع في الأمن السيبراني •

تكامل مع أدوات تحليل وتصور البيانات •

تحديثات دورية لتحسين الأمان والأداء •



Packets, Frames, Protocols :المفاهيم الأساسية

inventory_2)Packets( شرح الحزمview_week)Frames( شرح الإطارات

rule)Protocols( مفهوم البروتوكولاتhubالعلاقة بين هذه المفاهيم

إطاراتarrow_backحزمarrow_backبيانات

وحدة بيانات يتم نقلها عبر الشبكة •

تحتوي على العنوان والمحتوى •

)Payload( وحمل )Header( تتضمن رأس •

تختلف الحجم حسب البروتوكول المستخدم •

يمكن تقسيم البيانات الكبيرة إلى حزم متعددة •

وحدة بيانات في طبقة وصلة البيانات •

تغلف الحزم لإرسالها فعلياً •

تحتوي على عناوين MAC المصدر والوجهة •

تضيف معلومات للتحكم من الأخطاء •

تختلف حسب نوع الشبكة )إيثرنت، واي فاي، إلخ( •

قواعد تنظم الاتصال بين الأجهزة •

تحدد هيكل البيانات وطريقة إرسالها •

تنظم عملية المصافحة وإنهاء الاتصال •

TCP, IP, HTTP, DNS, DHCP :أمثلة •

OSI تعمل في طبقات مختلفة من نموذج •

البروتوكولات تحدد هيكل الحزم والإطارات •

البيانات تغلف في حزم وفقاً للبروتوكول •

الحزم تغلف في إطارات للنقل الفيزيائي •

Wireshark يحلل هذه العناصر طبقة طبقة •



إعداد بيئة تحليل الشبكة

checklistالمتطلبات الأساسيةsettings_ethernetإعداد الواجهات الشبكية

securityالاعتبارات الأمنيةtips_and_updatesأفضل الممارسات

جهاز كمبيوتر بمواصفات مناسبة •

مساحة تخزين كافية لملفات الالتقاط •

صلاحيات المسؤول للوصول للواجهات •

برنامج Wireshark مثبت بشكل صحيح •

WinPcap/Npcap برنامج تشغيل حزم البيانات  •

تحديد الواجهة المناسبة للاقتناص •

Promiscuous عند الحاجة تكوين وضع  •

Monitor اختيار وضع الالتقاط المناسب  •

ضبط إعدادات التصفية للواجهات •

اختبار الواجهة قبل بدء الالتقاط الفعلي •

الحصول على التصريحات اللازمة •

عدم التقاط بيانات حساسة دون إذن •

تأمين ملفات الالتقاط بشكل جيد •

عدم مشاركة البيانات التي تحتوي على معلومات خاصة •

الالتزام بالقوانين واللوائح المحلية •

استخدام فلاتر لتحديد البيانات المطلوبة •

تحديد حجم ملفات الالتقاط لتجنب استهلاك المساحة •

توثيق إعدادات البيئة والفلاتر المستخدمة •

العمل على بيئة معزولة عند التعلم •

الاحتفاظ بنسخ احتياطية من ملفات الالتقاط المهمة •



تثبيت Wireshark على جميع الأنظمة

القسم الثاني: التثبيت والتهيئة

computerWindows التثبيت علىterminalLinux التثبيت على

laptop_macmacOS التثبيت علىbuildالمشاكل الشائعة وحلولها

تحميل المثبت من الموقع الرسمي •

تشغيل المثبت كـ مسؤول •

Npcap اختيار المكونات المطلوبة  •

السماح بتثبيت Npcap عند الطلب •

إعادة تشغيل الجهاز بعد التثبيت •

yum apt أو  استخدام مدير الحزم  •

sudo apt install wireshark :أمر التثبيت •

wireshark إضافة المستخدم لمجموعة •

تثبيت الحزم الإضافية لدعم البروتوكولات •

تسجيل الخروج وإعادة الدخول لتطبيق الصلاحيات •

تحميل ملف .dmg من الموقع الرسمي •

سحب Wireshark إلى مجلد التطبيقات •

ChmodBPF للصلاحيات تثبيت  •

السماح بالوصول للواجهات من إعدادات الأمان •

إعادة تشغيل التطبيق بعد تثبيت الصلاحيات •

Npcap/ChmodBPF عدم ظهور الواجهات: تثبيت •

صلاحيات غير كافية: تشغيل كمسؤول •

مشاكل الاعتماديات: تثبيت الحزم المطلوبة •

تعارض مع برامج أخرى: إيقاف مؤقت للجدار الناري •

أخطاء التثبيت: تحميل إصدار متوافق مع النظام •



Npcapو WinPcap الفرق بين

القسم الثاني: التثبيت والتهيئة

historyWinPcap تعريفupgradeNpcap تعريف

compareالمقارنة بينهما

WinPcapNpcapالميزة

Windows 10/11 دعمclosecheck_circle

ممتازجيدالأداء

محسنمتوسطالأمان

مستمرةمتوقفةالتحديثات

help_outlineمتى تستخدم كل منهما

Windows مكتبة التقاط الحزم لنظام •

1999 بواسطة فريق من الباحثين تم تطويره في  •

يدعم التقاط وإرسال حزم البيانات الخام •

يعمل في وضع kernel لتحسين الأداء •

لم يتم تحديثه بنشط منذ عام 2013 •

WinPcap النسخة الحديثة من •

Wireshark مطورو تم تطويره بواسطة  •

Windows يدعم أحدث إصدارات •

يتضمن تحسينات أمنية وأداء أفضل •

Wireshark يتم تحديثه بانتظام مع •

Npcap: الخيار الموصى به دائماً •

10/11 أنظمة Windows الحديثة  •

عند الحاجة لأقصى أداء وأمان •

XP/7 WinPcap: الأنظمة القديمة  •

Npcap عند وجود تعارض مع •

للتوافق مع تطبيقات قديمة •



إعداد الصلاحيات والتحكم في الواجهات

القسم الثاني: التثبيت والتهيئة

admin_panel_settingsصلاحيات المسؤولsettings_ethernetالتحكم في الواجهات الشبكية

securityإعدادات الأمانmanage_accountsإدارة المستخدمين

تشغيل Wireshark كـ مسؤول للوصول الكامل •

wireshark في Linux: إضافة المستخدم لمجموعة  •

Run as administrator استخدام :Windows في •

ChmodBPF للصلاحيات في macOS: تثبيت  •

التحقق من الصلاحيات قبل بدء الالتقاط •

عرض الواجهات المتاحة في شاشة الترحيب •

تفعيل/تعطيل الواجهات حسب الحاجة •

اختيار وضع Promiscuous عند الضرورة •

الشبكات اللاسلكية إدارة واجهات  •

الشبكات الافتراضية تكوين واجهات  •

تقييد الوصول إلى ملفات الالتقاط •

تعطيل تشغيل البرامج تلقائياً •

تشفير ملفات الالتقاط الحساسة •

جدار الحماية المناسبة إعدادات  •

التحكم في صلاحيات القراءة والكتابة •

إنشاء مجموعات مستخدمين متخصصة •

تحديد صلاحيات مختلفة حسب الدور •

توزيع مهام الالتقاط والتحليل •

تتبع نشاط المستخدمين •

مراجعة الصلاحيات بشكل دوري •



واجهة Wireshark الرسومية: شرح تفصيلي

القسم الثاني: التثبيت والتهيئة

menuالقوائم الرئيسيةbuildشريط الأدوات

listنافذة عرض الحزمlayersنوافذ التفاصيل والبايتات

: فتح وحفظ ملفات الالتقاط File ملف •

: نسخ، بحث، وإعدادات Edit تحرير •

: تخصيص واجهة العرض View عرض •

: بدء وإيقاف الالتقاط Capture التقاط •

: تتبع الجلسات والفلاتر Analyze تحليل •

أزرار الالتقاط: بدء، إيقاف، وإعادة التشغيل •

أزرار الملفات: فتح، حفظ، وطباعة •

أزرار التنقل: الانتقال بين الحزم •

أزرار العرض: تكبير وتصغير •

أزرار التلوين: تفعيل وإيقاف التلوين •

التقاط ملف عرض

التنقل التلوين

عرض قائمة الحزم الملتقطة •

أعمدة: رقم الحزمة، الوقت، المصدر، الوجهة •

عرض البروتوكول والمعلومات •

إمكانية الفرز حسب الأعمدة •

تلوين الحزم حسب البروتوكولات •

رقم الوقت المصدر الوجهة البروتوكول

قائمة الحزم

نافذة التفاصيل: تحليل طبقات الحزمة •

عرض البروتوكولات المتداخلة •

نافذة البايتات: عرض البيانات الخام •

عرض النص والسداسي عشري •

إبراز الجزء المحدد من الحزمة •

نافذة التفاصيل

نافذة البايتات



التحكم في الأداء وإعدادات الفلترة التلقائية
القسم الثاني: التثبيت والتهيئة

speedWireshark تحسين أداءfilter_altإعدادات الفلترة التلقائية

memoryإدارة الذاكرةfolder_openالتعامل مع ملفات التتبع الكبيرة

تعطيل تحليل البروتوكولات غير الضرورية •

استخدام فلاتر الالتقاط لتقليل البيانات •

إغلاق النوافذ غير المستخدمة •

تحديث Wireshark لأحدث إصدار •

Cache زيادة ذاكرة التخزين المؤقت  •

تفعيل الفلاتر التلقائية للبروتوكولات •

إنشاء قوائم فلترة مخصصة •

MAC IP أو  إعدادات الفلترة حسب  •

فلترة حسب نوع الحزمة أو المحتوى •

حفظ الفلاتر الشائعة للاستخدام السريع •

Wireshark تحديد حجم الذاكرة المخصص لـ •

ضبط عدد الحزم المعروضة في القائمة •

تفريغ الذاكرة بعد كل عملية تحليل •

Garbage Collection بشكل دوري استخدام  •

مراقبة استخدام الذاكرة أثناء التشغيل •

تقسيم الملفات الكبيرة إلى أجزاء أصغر •

استخدام ملفات متعددة للتقاط طويل •

أجزاء محددة من الملف تحميل  •

تصدير البيانات المطلوبة فقط •

استخدام أدوات خارجية لمعالجة الملفات الضخمة •



التقاط البيانات من الواجهات الصحيحة

القسم الثالث: التقاط البيانات الحية

routerتحديد الواجهات الشبكية المناسبةsettings_input_componentالتقاط البيانات في أوضاع مختلفة

wifiالتقاط البيانات من الشبكات اللاسلكيةbuildمشاكل وحلول شائعة

فهم طوبولوجيا الشبكة الحالية •

اختيار الواجهة الأقرب للهدف •

التحقق من حالة الواجهات النشطة •

ipconfig للتحقق ifconfig أو  استخدام  •

اختيار الواجهة ذات حركة المرور المطلوبة •

وضع Promiscuous لرؤية كل الحزم •

وضع Monitor للشبكات اللاسلكية •

الحزم الواردة فقط التقاط  •

الحزم الصادرة فقط التقاط  •

التقاط في وضع الجسر للشبكات المعقدة •

اختيار بطاقة لاسلكية تدعم وضع المراقبة •

Wireshark التحقق من توافق البطاقة مع •

Monitor Mode لرؤية جميع الحزم استخدام  •

تحديد القناة الصحيحة للشبكة المستهدفة •

مراعاة قيود التشفير في الشبكات اللاسلكية •

عدم ظهور الواجهات: تثبيت برامج التشغيل •

صلاحيات غير كافية: تشغيل كمسؤول •

: بطاقات غير متوافقة الشبكات اللاسلكية مشاكل  •

فقدان الحزم: زيادة حجم المخزن المؤقت •

أخطاء التعارض: إيقاف برامج الجدار الناري •



Capture Filters: الصياغة والتطبيق

القسم الثالث: التقاط البيانات الحية

filter_altأساسيات فلاتر الالتقاطcodeصياغة فلاتر فعالة

tcp port 80 and host 192.168.1.1

lightbulbأمثلة عملية

tcp portrange 1-1024 and not host

192.168.1.100

psychologyنصائح متقدمة

(tcp src port 80) and (tcp dst port 1024-

5000)

تعمل على مستوى kernel قبل المعالجة •

Berkeley Packet Filter BPF تستخدم صيغة •

تقلل من حجم البيانات الملتقطة •

Wireshark بشكل كبير تحسن أداء •

تطبق قبل حفظ الحزم في الذاكرة •

< > =! == استخدام عوامل المقارنة:  •

OR و AND الربط بين الشروط بـ •

tcp, udp, icmp :فلترة حسب البروتوكول •

port 80, port 443 :فلترة حسب المنفذ •

IP: host 192.168.1.1 فلترة حسب عنوان •

HTTP traffic: tcp port 80 or tcp port 8080 •

HTTPS traffic: tcp port 443 •

DNS traffic: udp port 53 •

ARP traffic: arp •

ICMP traffic: icmp •

استخدام الأقواس لتحديد أولوية العمليات •

portrange 20-80 :فلترة حسب نطاق المنافذ •

less 100, greater 500 :فلترة حسب حجم الحزمة •

not host 192.168.1.1 :استبعاد عناوين محددة •

src, dst :فلترة حسب اتجاه البيانات •



تسجيل البيانات التلقائي والمجدول
القسم الثالث: التقاط البيانات الحية

auto_modeإعداد التسجيل التلقائيscheduleالتقاط مجدول

storageإدارة مساحة التخزينtips_and_updatesأفضل الممارسات

تفعيل ملفات متعددة في إعدادات الالتقاط •

تحديد حجم الملف الأقصى لكل ملف •

pcapng اختيار تنسيق الملف المناسب  •

إعداد تسمية تلقائية للملفات •

تفعيل الاستمرارية بين الملفات •

استخدام مهام مجدولة في نظام التشغيل •

أوامر tshark للاستخدام في السكربتات •

تحديد الفترات الزمنية للاقتناص •

Windows في Task Scheduler cron في Linux أو  دمج مع  •

إعداد الإشعارات عند انتهاء الالتقاط •

تحديد عدد الملفات الأقصى •

ring buffer تفعيل الحلقة التلقائية •

إعداد الضغط التلقائي للملفات القديمة •

نقل الملفات إلى تخزين خارجي •

حذف الملفات القديمة تلقائياً •

استخدام فلاتر الالتقاط لتقليل البيانات •

توثيق إعدادات الالتقاط المستخدمة •

مراقبة مساحة التخزين بانتظام •

حماية الملفات الحساسة بتشفيرها •

عمل نسخ احتياطية للملفات المهمة •



قراءة الحزم المشفرة وغير المشفرة

القسم الثالث: التقاط البيانات الحية

enhanced_encryptionالتعرف على الحزم المشفرةtext_snippetتحليل الحزم غير المشفرة

warningالتحديات في تحليل الحزم المشفرةlightbulbحلول عملية

TLS/SSL بحث عن بروتوكولات التشفير •

تحليل مصافحة TLS في بداية الاتصال •

التعرف على المنافذ المشفرة الشائعة •

فحص رؤوس الحزم للإشارات المشفرة •

مراقبة شهادات SSL المتبادلة •

استعراض المحتوى النصي مباشرة •

FTP و HTTP تحليل بروتوكولات •

استخراج المعلومات الحساسة غير المحمية •

فحص البيانات الوصفية للحزم •

استخدام ميزة Follow Stream لإعادة بناء الجلسات •

عدم القدرة على رؤية المحتوى الفعلي •

صعوبة فك التشفير بدون مفاتيح •

تعقيد خوارزميات التشفير الحديثة •

مشاكل الأداء عند محاولة فك التشفير •

قيود قانونية وأخلاقية في فك التشفير •

SSLKEYLOGFILE استخدام مفتاح فك التشفير •

تحليل البيانات الوصفية بدلاً من المحتوى •

التركيز على أنماط الاتصال وسلوكها •

استخدام وسيط TLS لفك تشفير الاتصالات •

التحليل قبل وبعد مرحلة التشفير •



اكتشاف الأنشطة الغريبة في الوقت الفعلي
القسم الثالث: التقاط البيانات الحية

visibilityمراقبة الشبكة المباشرةwarningمؤشرات الأنشطة المشبوهة

notifications_activeإعداد التنبيهاتboltالاستجابة السريعة

استخدام واجهة المراقبة المباشرة •

تفعيل التحديث التلقائي للحزم •

مراقبة معدل الحزم في الوقت الفعلي •

I/O Graph لرصد الأنماط استخدام  •

مراقبة الاستخدام غير الطبيعي للنطاق •

زيادة مفاجئة في حركة المرور •

اتصالات من عناوين غريبة •

Port Scanning محاولات مسح المنافذ •

تبادل بيانات غير معتادة بين الأجهزة •

استخدام بروتوكولات نادرة أو غير معروفة •

استخدام فلاتر العرض للأنشطة المشبوهة •

تكوين إشعارات ملونة للمخاطر •

SIEM أنظمة ربط Wireshark مع  •

إعداد تنبيهات عبر البريد أو الرسائل •

تخصيص قواعد التنبيه حسب سياسة الشبكة •

عزل الأجهزة المصابة فوراً •

حظر عناوين IP المشبوهة •

إغلاق المنافذ المستهدفة •

توثيق الأدلة الرقمية للتحقيق •

تنفيذ خطة الطوارئ الأمنية •



Ethernet > IP > TCP > HTTP :تفسير الطبقات

القسم الرابع: تحليل الحزم البروتوكولية

layersOSI/TCP-IP نموذج

apps)HTTP, FTP, DNS( التطبيق

swap_horiz)TCP, UDP( النقل

router)IP, ICMP( الشبكة

settings_ethernet)Ethernet( الوصلة

settings_ethernetEthernet تحليل طبقة

routerIP تحليل طبقةswap_horizTCP تحليل طبقة

languageHTTP تحليل طبقة

نموذج OSI: 7 طبقات هرمية •

نموذج TCP/IP: 4 طبقات عملية •

كل طبقة تغلف البيانات من الطبقة الأعلى •

Wireshark يعرض التفكيك الكامل للطبقات •

تحليل الطبقات يساعد في تشخيص المشاكل •

TCP/IP الطبقة الأدنى في نموذج •

تحتوي على عناوين MAC المصدر والوجهة •

تحديد نوع البروتوكول في الطبقة الأعلى •

EtherType لتحديد البروتوكول التالي تحليل  •

كشف الإطارات التالفة أو غير الصالحة •

تحتوي على عناوين IP المصدر والوجهة •

IPv4/IPv6 تحديد إصدار البروتوكول •

TTL (Time To Live) تحليل حقل •

فحص تجزئة الحزم وإعادة تجميعها •

تحديد البروتوكول في الطبقة الأعلى •

تحليل مصافحة TCP الثلاثية •

فحص أرقام المنافذ المصدر والوجهة •

مراقبة أرقام التسلسل والإقرارات •

كشف إعادة الإرسال وفقدان الحزم •

SYN, ACK, FIN, RST تحليل إشارات التحكم •

HTTP (GET, POST, PUT) تحليل طلبات •

فحص رؤوس HTTP والمعلومات الوصفية •

استعراض محتوى الرسائل والبيانات •

500 ,404 ,200 تحليل كودات الحالة •

استخدام Follow TCP Stream لإعادة بناء المحادثة •



TCP Handshake تحليل

القسم الرابع: تحليل الحزم البروتوكولية

swap_horizTCP Handshake مراحلfind_in_pageتفسير الحزم

error_outlineTCP Handshake مشاكل شائعة فيbuildتطبيقات عملية

SYN: العميل يبدأ الاتصال •

SYN-ACK: الخادم يستجيب ويوافق •

ACK: العميل يؤكد الاستلام •

بعد اكتمال المصافحة، يبدأ نقل البيانات •

SYN=1، ACK=0 علم :SYN حزمة •

SYN=1، ACK=1 علم :SYN-ACK حزمة •

SYN=0، ACK=1 علم :ACK حزمة •

ISN مراقبة أرقام التسلسل الأولية  •

Window Size تحليل حجم النافذة •

فشل المصافحة: عدم استجابة الخادم •

SYN/ACK إعادة الإرسال: فقدان حزم •

Timeout انتهاء المهلة •

Connection Refused رفض الاتصال •

ازدحام الشبكة وتأخير الاستجابة •

تشخيص مشاكل الاتصال بالخوادم •

كشف جدار الحماية الذي يحجب المنافذ •

تحليل أداء الشبكة وسرعة الاستجابة •

مراقبة محاولات الاختراق والمسح الضوئي •

تحسين إعدادات TCP للأداء الأفضل •

SYN 1SYN-ACK 2ACK 3



TLS و DHCP و DNS تحليل

القسم الرابع: تحليل الحزم البروتوكولية

dnsDNS تحليل حزمrouterDHCP تحليل حزم

enhanced_encryptionTLS تحليل حزمhubالعلاقة بين هذه البروتوكولات

Query تحليل طلبات الاستعلام •

Response فحص الإجابات •

A, AAAA, MX, CNAME مراقبة أنواع السجلات •

كشف محاولات التسمية غير الصالحة •

تحليل زمن الاستجابة للخوادم •

DORA مراقبة عملية الاكتشاف •

Discover, Offer, Request, Ack :تحليل الرسائل •

فحص عناوين MAC و IP المخصصة •

Lease Renewal مراقبة تجديد الإيجار •

كشف الخوادم غير المصرح بها •

Handshake TLS فحص مصافحة •

Certificate Exchange تحليل تبادل الشهادات •

مراقبة خوارزميات التشفير المستخدمة •

1.3 ,1.2 TLS فحص إصدارات •

Change Cipher Spec تحليل تغيير تشفير •

DHCP يوفر IP للجهاز للاتصال بالشبكة •

IP يحول أسماء النطاقات إلى عناوين DNS •

TLS يؤمن الاتصال بعد إنشائه •

تعمل معاً لتمكين الاتصال الآمن •

مشاكل في أي منها تؤثر على تجربة المستخدم •

DHCPDNSTLS



Follow Stream :تتبع الجلسات

القسم الرابع: تحليل الحزم البروتوكولية

timelineمفهوم تتبع الجلساتplay_circleFollow Stream استخدام ميزة

buildتطبيقات عمليةpsychologyنصائح متقدمة

إعادة بناء المحادثات الكاملة •

تجميع الحزم المتعلقة بنفس الجلسة •

عرض تسلسل البيانات المتبادلة •

المرسل/المستقبل فصل اتجاهات التدفق •

تحويل البيانات الثنائية إلى نص مقروء •

TCP النقر الأيمن على حزمة •

Follow > TCP Stream اختيار •

عرض المحتوى الكامل للجلسة •

إمكانية التصفية حسب المحتوى •

حفظ الجلسة كملف منفصل •

HTTP طلب

استجابة

بيانات

إغلاق

استخراج المحتوى النصي للمحادثات •

HTTP, FTP, SMTP تحليل بروتوكولات التطبيق •

كشف بيانات الاعتماد المنقولة •

فحص محتوى الملفات المنقولة •

تشخيص مشاكل التطبيقات عبر الشبكة •

استخدام فلاتر العرض قبل التتبع •

تفعيل تمييز الألوان للاتجاهات المختلفة •

Base64 تحويل البيانات المشفرة •

دمج عدة جلسات متصلة •

استخدام النسخ الاحتياطي للجلسات المهمة •



تحليل الجلسات المشفرة ومحاولات فك التشفير

القسم الرابع: تحليل الحزم البروتوكولية

enhanced_encryptionSSL/TLS تحليل جلساتvpn_keyمحاولات فك التشفير

keyاستخدام مفتاح فك التشفيرwarningتحديات وحلول

Handshake TLS فحص مصافحة •

تحليل شهادات SSL المتبادلة •

مراقبة خوارزميات التشفير المستخدمة •

TLS 1.2/1.3 فحص إصدارات البروتوكول •

Change Cipher Spec تحليل تغيير تشفير •

Key Log استخدام ملفات المفاتيح •

محاولة كسر التشفير بالقوة الغاشمة •

استغلال ثغرات البروتوكول •

TLS Proxy TLS استخدام وسيط •

تحليل البيانات الوصفية بدلاً من المحتوى •

SSLKEYLOGFILE إعداد متغير البيئة •

Wireshark استيراد ملفات المفاتيح في •

تكوين إعدادات TLS لفك التشفير •

Pre-Shared Keys استخدام مفاتيح ما قبل التوزيع •

FTPS و HTTPS فك تشفير جلسات •

بيانات مفكوكةarrow_backمفتاح فك التشفيرarrow_backبيانات مشفرة

AES-256 تعقيد التشفير الحديث  •

صعوبة الحصول على المفاتيح الصحيحة •

مشاكل الأداء عند فك التشفير •

قيود قانونية وأخلاقية في فك التشفير •

استخدام بدائل مثل تحليل البيانات الوصفية •



Display Filtersو Capture الفرق بين

القسم الخامس: الفلاتر والتحكم في العرض

filter_altتعريف فلاتر الالتقاط

tcp port 80 and host 192.168.1.1

visibilityتعريف فلاتر العرض

tcp.port == 80 && ip.addr == 192.168.1.1

help_outlineمتى تستخدم كل نوعcompareمقارنة وأمثلة عملية

فلتر العرضفلتر الالتقاطالغرض

HTTP traffictcp port 80tcp.port == 80

IP addresshost 192.168.1.1ip.addr == 192.168.1.1

Protocolicmpicmp

تعمل على مستوى kernel قبل المعالجة •

Berkeley Packet Filter BPF تستخدم صيغة •

Wireshark تمنع وصول الحزم إلى •

تحسن الأداء وتقلل استخدام الموارد •

محدودة في التعقيد والقدرات •

تعمل على مستوى التطبيق بعد الالتقاط •

تستخدم صيغة Wireshark الخاصة •

تخفي عرض الحزم غير المطابقة •

لا تؤثر على الأداء أثناء الالتقاط •

مرنة جداً و قوية في التحليل •

فلاتر الالتقاط: •

عند وجود حركة مرور كثيفة •

للتقاط بيانات محددة فقط •

عند العمل على موارد محدودة •

فلاتر العرض: •

لتحليل بيانات ملتقطة بالفعل •

للبحث عن أنماط معقدة •

عند الحاجة لـ مرونة في التحليل •



كتابة فلاتر متقدمة

القسم الخامس: الفلاتر والتحكم في العرض

codeصياغة الفلاتر المتقدمة

tcp.flags.syn == 1 && tcp.flags.ack == 0

functionsاستخدام العوامل المنطقية

)AND( &&)OR( ||

)NOT( !)XOR( ^^

find_in_pageفلاتر قائمة على المحتوى

http contains "password" || frame contains

"00:11:22"

psychologyأمثلة معقدة

tcp.port > 1024 && !tcp.analysis.flags

http.request.method == "POST" &&

http.file_data

tcp.analysis.retransmission ||

tcp.analysis.duplicate_ack

استخدام النقاط للوصول للحقول الفرعية •

تحديد البروتوكولات المتداخلة •

الوصول إلى الحقول المخفية •

فلترة حسب القيم العددية •

استخدام النطاقات والقيم النسبية •

: تحقيق جميع الشروط && AND •

: تحقيق أي شرط || OR •

: نفي الشرط ! NOT •

: تحقيق شرط واحد فقط ^^ XOR •

استخدام الأقواس لتحديد الأولوية •

البحث عن نصوص محددة في الحزم •

فلترة حسب القيم السداسية عشر •

Regex استخدام التعبيرات النمطية •

فلترة حسب الأحجام والأطوال •

مقارنة البايتات والبتات •

فلترة الاتصالات المشبوهة: •

كشف محاولات الاختراق: •

تحليل الأخطاء في الشبكة: •



فلاتر خاصة بالبروتوكولات

القسم الخامس: الفلاتر والتحكم في العرض

routerTCP/IP فلاتر بروتوكول

ip.addr == 192.168.1.1 && tcp.port == 80

languageHTTP فلاتر بروتوكول

http.request.method == "POST" &&

http.content_type == "application/json"

dnsDNS فلاتر بروتوكول

dns.qry.name contains "example.com" &&

dns.resp.code == 0

layersفلاتر بروتوكولات أخرى

dhcp.option.type == 53 || arp.src.hw_mac ==

00:11:22:33:44:55

فلترة حسب عناوين IP المصدر والوجهة •

Ports فلترة حسب المنافذ •

Flags TCP فلترة حسب أعلام •

Window Size فلترة حسب حجم النافذة •

Sequence Numbers فلترة حسب أرقام التسلسل •

GET, POST فلترة حسب نوع الطلب •

Status Code فلترة حسب رمز الحالة •

Content-Type فلترة حسب نوع المحتوى •

فلترة حسب عنوان URL أو المسار •

Host فلترة حسب المضيف •

Query Type فلترة حسب نوع الاستعلام •

Record Type فلترة حسب نوع السجل •

Domain Name فلترة حسب اسم النطاق •

Response Code فلترة حسب رمز الاستجابة •

فلترة حسب خوادم DNS المستخدمة •

DHCP: فلترة حسب نوع الرسالة •

MAC فلترة حسب عناوين :ARP •

ICMP: فلترة حسب نوع الرسالة •

TLS/SSL: فلترة حسب إصدار التشفير •

FTP: فلترة حسب أوامر الملفات •



AND / OR الفلاتر المركبة

القسم الخامس: الفلاتر والتحكم في العرض

join_fullAND/OR استخدام العوامل

)&&( AND)||( OR

low_priorityترتيب الأولويات

) ( الأقواس1

2NOT !

3AND &&

4OR ||

codeأمثلة عملية

tcp.port == 80 || tcp.port == 443

ip.addr == 192.168.1.1 && tcp.port == 80

(tcp || udp) && ip.src == 10.0.0.1

tips_and_updatesنصائح للفلاتر الفعالة

(tcp.port == 80 || tcp.port == 443) &&

!ip.src == 192.168.1.100

AND )&&(: تحقيق جميع الشروط معاً •

OR )||(: تحقيق أي شرط من الشروط •

دمج شروط متعددة في فلتر واحد •

تضييق نطاق البحث بشكل دقيق •

زيادة فعالية الفلترة •

الأقواس لها الأسبقية القصوى •

)&&( AND ثم )!( NOT ثم •

أخيراً OR )||( الأقل أولوية •

استخدام الأقواس لـ تحديد الأولوية •

تجنب التباس في النتائج •

: فلترة HTTP و HTTPS معاً •

فلترة عنوان IP ومنفذ محددين: •

فلترة بروتوكولات متعددة: •

استخدام الأقواس دائماً للوضوح •

تجنب التعقيد الزائد في الفلتر •

اختبار كل شرط على حدة أولاً •

استخدام التعليقات للفلاتر المعقدة •

حفظ الفلاتر الشائعة للاستخدام المستقبلي •



تخصيص الألوان لتتبع الحزم بسهولة

القسم الخامس: الفلاتر والتحكم في العرض

ruleإعداد قواعد التلوينpaletteتخصيص الألوان للبروتوكولات

TCPUDPHTTPDNSTLS

format_color_fillتخصيص الألوان للمحتوى

خطأ
إعادة
إرسال

حساستحكم

lightbulbأفضل الممارسات

تنبيهمهمخطرآمنعادي

View > Coloring Rules الوصول إلى قائمة التلوين من •

إنشاء قواعد جديدة أو تعديل الموجودة •

تحديد اسم القاعدة والفلتر المرتبط •

اختيار لون الخلفية ولون النص •

تحديد ترتيب الأولوية للقواعد •

تمييز بروتوكولات TCP باللون الأزرق •

تمييز بروتوكولات UDP باللون الأخضر •

تمييز بروتوكول HTTP باللون البرتقالي •

تمييز بروتوكول DNS باللون الأصفر •

تمييز بروتوكولات التشفير باللون البنفسجي •

تلوين الحزم المشبوهة باللون الأحمر •

تلوين الأخطاء باللون الأحمر الفاتح •

تلوين إعادة الإرسال باللون الأصفر •

تلوين حزم التحكم باللون الرمادي •

تلوين المحتوى الحساس باللون الأحمر الداكن •

استخدام ألوان محايدة لمعظم الحزم •

تخصيص ألوان زاهية للحزم المهمة •

تجنب الألوان المتشابهة للبروتوكولات المختلفة •

حفظ قواعد التلوين للاستخدام المستقبلي •

Wireshark تفعيل التلوين التلقائي عند بدء •



)pcap, csv, json( حفظ الملفات بصيغ مختلفة

القسم السادس: التصدير والتقارير

descriptionصيغ الملفات المدعومة

pcapcsvjson

help_outlineمتى تستخدم كل صيغة

saveحفظ الملفات بطرق مختلفةbuildمشاكل وحلول شائعة

pcap/pcapng: الصيغة القياسية لحزم الشبكة •

csv: بيانات جدولية للتحليل الإحصائي •

json: بيانات منظمة للتطبيقات البرمجية •

txt: نص عادي للقراءة المباشرة •

psml: صيغة Wireshark للبيانات الوصفية •

pcap/pcapng: للحفظ الكامل للبيانات الخام •

csv: للتحليل في Excel أو أدوات البيانات •

json: للتكامل مع تطبيقات الويب والبرمجة •

txt: للتقارير النصية البسيطة •

Wireshark للاستيراد مرة أخرى في :psml •

File > Save: حفظ جميع الحزم •

File > Export Specified Packets: حفظ مختار •

File > Export Packet Dissections: حفظ التفاصيل •

File > Export Objects: استخراج الملفات •

استخدام سطر الأوامر tshark للتصدير الآلي •

: تقسيمها إلى أجزاء أصغر ملفات كبيرة جداً •

فقدان البيانات: التأكد من اختيار الصيغة المناسبة •

pcap بدلاً من pcapng مشاكل التوافق: استخدام •

صلاحيات الكتابة: التحقق من صلاحيات المجلد •

تلف الملفات: التحقق من سلامة الملف قبل الحفظ •



تحليل ملفات ضخمة وتجزئتها

القسم السادس: التصدير والتقارير

folder_openالتعامل مع الملفات الكبيرةcontent_cutتقسيم الملفات

أجزاء أصغرarrow_backملف كبير

find_in_pageتحليل مقاطع محددةspeedتحسين الأداء

Wireshark زيادة ذاكرة النظام المخصصة لـ •

استخدام فلاتر العرض لتقليل البيانات المعروضة •

تفعيل التحميل التدريجي للملفات •

إغلاق النوافذ غير الضرورية أثناء التحميل •

استخدام أجهزة قوية للمعالجة •

File > Export Specified Packets استخدام •

التقسيم حسب الزمن أو عدد الحزم •

editcap استخدام أدوات سطر الأوامر مثل  •

التقسيم حسب عناوين IP أو البروتوكولات •

حفظ الأجزاء في ملفات منفصلة •

استخدام فلاتر دقيقة لتحديد المقاطع المطلوبة •

التركيز على الفترات الزمنية المهمة •

تحليل الجلسات المحددة فقط •

استخراج الحزم ذات الصلة بالحدث •

Bookmarks استخدام الإشارات المرجعية •

تعطيل تحليل البروتوكولات غير الضرورية •

تقليل عدد الحزم المعروضة •

استخدام الذاكرة المؤقتة بكفاءة •

تفادي العمليات المعقدة على الملفات الكبيرة •

استخدام أدوات خارجية للمعالجة المسبقة •



تصدير الحزم المحددة فقط

القسم السادس: التصدير والتقارير

checklistتحديد الحزم المطلوبةsettingsخيارات التصدير

check_boxالمحددة فقطfilter_altبعد الفلترةaccess_timeحسب النطاق الزمني

data_objectتصدير البيانات الوصفيةcodeأمثلة عملية

Ctrl/Cmd استخدام التحديد اليدوي مع •

تطبيق فلاتر العرض لتحديد الحزم •

التحديد حسب النطاق الزمني •

التحديد حسب البروتوكول أو النوع •

Bookmarks استخدام الإشارات المرجعية •

File > Export Specified Packets •

اختيار نطاق الحزم المطلوب تصديرها •

تحديد صيغة الملف المناسبة •

اختيار تضمين أو استبعاد معلومات معينة •

إمكانية الضغط للملفات الكبيرة •

تصدير معلومات الحزم الأساسية •

استخراج تفاصيل البروتوكولات •

Raw Data تصدير البيانات الخام •

تضمين الطوابع الزمنية والمعلومات الإضافية •

حفظ معلومات الواجهة والالتقاط •

تصدير جلسة TCP كاملة •

استخراج حزم HTTP فقط •

تصدير محادثة DNS محددة •

فصل حزم التحكم عن حزم البيانات •

إنشاء تقرير من حزم محددة •



مشاركة ملفات التحليل مع فريق التحقيق

القسم السادس: التصدير والتقارير

inventoryإعداد الملفات للمشاركةsecurityحماية البيانات الحساسة

descriptionتوثيق النتائجshareأدوات المشاركة

تصدير الحزم ذات الصلة فقط •

تنظيم الملفات حسب التصنيف •

تضمين معلومات السياق الضرورية •

Compression ضغط الملفات الكبيرة  •

إعداد قائمة المحتويات للملفات •

إخفاء أو تشويه البيانات الشخصية •

إزالة بيانات الاعتماد والمفاتيح •

تشفير الملفات بكلمة مرور قوية •

تطبيق قيود الوصول للملفات •

الالتزام بـ سياسات الخصوصية •

إنشاء ملف ملخص للتحليل •

توضيح المنهجية المستخدمة •

توثيق الاستنتاجات الرئيسية •

إرفاق لقطات شاشة توضيحية •

تضمين التواريخ والأوقات الدقيقة •

استخدام المنصات الآمنة للمشاركة •

التحكم في صلاحيات الوصول •

تفعيل التتبع للملفات المشتركة •

استخدام أدوات التعاون عن بعد •

توفير الدعم الفني لاستخدام الملفات •

4 المشاركة3 التوثيق2 الأمان1 التحضير



مقارنة الجلسات وتحليل التباين الزمني

القسم السادس: التصدير والتقارير

compareمقارنة الجلسات المختلفة

جلسة 2جلسة 1

scheduleتحليل التوقيتات الزمنية

10ms12ms45ms11ms

timelineاكتشاف الأنماطbuildتطبيقات عملية

استخدام ملفات متعددة للمقارنة •

تحليل اختلافات الأداء بين الجلسات •

مقارنة سلوك البروتوكولات •

تحديد التغيرات في أنماط الاتصال •

استخدام أدوات الرسوم البيانية للمقارنة •

Response Time قياس زمن الاستجابة •

تحليل الفواصل الزمنية بين الحزم •

Latency مراقبة تأخير الشبكة •

حساب معدل نقل البيانات •

تحديد الاختناقات في الأداء •

تحديد الدورات المتكررة في الاتصالات •

كشف الشذوذ في الأنماط المعتادة •

تحليل التغيرات الموسمية في حركة المرور •

مراقبة اتجاهات الأداء عبر الزمن •

استخدام التحليل الإحصائي للأنماط •

تحسين أداء التطبيقات والشبكات •

كشف الهجمات السيبرانية عبر تحليل الأنماط •

تحديد أوقات الذروة في استخدام الشبكة •

تخطيط السعة والموارد المطلوبة •

إنشاء خطوط أساسية للأداء الطبيعي •



ARP Spoofing كشف

القسم السابع: استخدام Wireshark في الأمن السيبراني

warningARP Spoofing شرح هجوم

A الضحيةarrow_backالمهاجمarrow_backB الضحية

find_in_pageWireshark مؤشرات الهجوم في

analyticsتحليل الحزم المشبوهةsecurityالوقاية والاستجابة

هجوم انتحال الهوية على مستوى الشبكة •

يرسل المهاجم رسائل ARP مزيفة •

يربط عنوان MAC الخاص به بعنوان IP للضحية •

يتمكن من اعتراض البيانات المرسلة •

Man-in-the-Middle MITM يمكن تنفيذ هجمات •

IP متكررة لنفس ARP وجود رسائل •

تغيير عناوين MAC لنفس IP بشكل مفاجئ •

Gratuitous ARP غير مطلوبة ARP رسائل •

غير طبيعية ARP حركة مرور •

IP متعددة لنفس MAC وجود عناوين •

arp فلترة حركة المرور بـ •

Request/Reply ARP فحص نوع رسالة •

مقارنة عناوين MAC مع السجلات المعروفة •

مراقبة تواتر الرسائل غير الطبيعي •

Wireshark في ARP استخدام إحصائيات •

Static ARP تنفيذ إدخالات ARP ثابتة •

ARP استخدام برامج الحماية من هجمات •

تفعيل ميزات الأمان في المعدات الشبكية •

مراقبة الشبكة بشكل مستمر •

عزل الأجهزة المصابة فوراً •



DNS Poisoning كشف

القسم السابع: استخدام Wireshark في الأمن السيبراني

warningDNS Poisoning شرح هجوم

خادم arrow_backDNSالمهاجمarrow_backالضحية

find_in_pageWireshark مؤشرات الهجوم في

analyticsالمشبوهة DNS تحليل حزمsecurityالوقاية والاستجابة

DNS هجوم يستهدف تسميم ذاكرة •

يحقن المهاجم سجلات DNS مزيفة •

يحول المستخدمين إلى مواقع ضارة •

يمكن سرقة بيانات الاعتماد والمعلومات •

DNS Spoofing DNS Cache Poisoning و  أنواع:  •

سريعة جداً DNS استجابات •

استجابات DNS من خوادم غير معروفة •

غير متوقعة في الاستجابات IP عناوين •

عدد كبير من استجابات DNS لطلب واحد •

تكرار نفس استجابة DNS بشكل غير طبيعي •

dns فلترة حركة المرور بـ •

فحص نوع الاستعلام والاستجابة •

مقارنة عناوين IP مع القوائم البيضاء •

Response Time مراقبة زمن الاستجابة •

Wireshark في DNS استخدام إحصائيات •

استخدام DNSSEC للتحقق من الاستجابات •

DNS over TLS تفعيل DNS over HTTPS أو  •

تحديث برامج مكافحة الفيروسات •

مراقبة سجلات DNS بشكل دوري •

عزل الأجهزة المصابة فوراً •



DDoSو SYN Flood تحليل

القسم السابع: استخدام Wireshark في الأمن السيبراني

warningDDoSو SYN Flood شرح هجمات

مهاجم arrow_back2الهدفarrow_backمهاجم 1

find_in_pageWireshark مؤشرات الهجوم في

analyticsتحليل أنماط الهجوم

trending_upزيادة مفاجئةshuffleمصادر متعددةblockفشل المصافحة

securityالاستجابة والتخفيف

SYN Flood: إغراق الخادم بطلبات اتصال مزيفة •

Distributed DDoS: هجوم من مصادر متعددة  •

استنزاف موارد الخادم حتى يتعطل •

منع المستخدمين الشرعيين من الوصول •

أهداف: توقف الخدمة أو تشتيت الانتباه •

ACK بدون SYN عدد كبير من حزم •

حزم من عناوين IP متنوعة لنفس المنفذ •

حجم غير طبيعي لحركة المرور •

زيادة مفاجئة في طلبات الاتصال •

فشل مصافحة TCP الثلاثية •

tcp.flags.syn == 1 فلترة حركة المرور بـ •

تحليل مصدر الحزم وتوزيعها الجغرافي •

مراقبة المنافذ المستهدفة •

قياس معدل الحزم في الثانية •

Wireshark في TCP استخدام إحصائيات •

تفعيل SYN Cookies على الخوادم •

WAF استخدام جدار حماية متخصص  •

زيادة سعة الخادم أو استخدام موازنة التحميل •

التعاون مع مزود الخدمة لمنع الهجوم •

DDoS استخدام خدمات الحماية من •



Man-in-the-Middle تتبع هجمات

القسم السابع: استخدام Wireshark في الأمن السيبراني

warningMan-in-the-Middle شرح هجمات

الخادمarrow_backالمهاجمarrow_backالضحية

find_in_pageWireshark مؤشرات الهجوم في

analyticsتحليل الجلسات المخترقة

httpsشهادات غير صالحةswap_horizاتصالات مزدوجة

securityالوقاية والاستجابة

المهاجم يتوسط بين الطرفين •

يعترض الاتصالات بشكل خفي •

يمكن قراءة وتعديل البيانات •

DNS Spoofing  ، ARP Spoofing أنواع:  •

قد لا يلاحظها المستخدمون •

IP لنفس ARP تكرار رسائل •

استجابات DNS من خوادم غير معروفة •

غير صالحة SSL/TLS شهادات •

تغير عناوين MAC بشكل متكرر •

اتصالات مزدوجة لنفس الجلسة •

فحص مصافحة TCP الثلاثية •

SSL/TLS تحليل شهادات •

مراقبة تسلسل الحزم غير الطبيعي •

استخدام Follow Stream لفحص المحادثات •

تحليل البيانات الوصفية للحزم •

HTTP بدلاً من HTTPS استخدام •

تفعيل HSTS في المتصفحات •

استخدام شبكات VPN موثوقة •

تفعيل التحقق من الشهادات •

عزل الأجهزة المشبوهة فوراً •



استرجاع الملفات والصور من الشبكة

القسم السابع: استخدام Wireshark في الأمن السيبراني

file_downloadاستخراج الملفات من الحزمswap_horizتحليل بروتوكولات نقل الملفات

imageصورdescriptionنصوصvideocamفيديو

buildأدوات مساعدةwarningقيود وتحديات

File > Export Objects استخدام •

اختيار نوع الملف المطلوب استخراجه •

استخدام Follow TCP Stream لإعادة بناء الملفات •

حفظ الملفات المستخرجة بصيغها الأصلية •

استخراج البيانات الثنائية من الحزم •

HTTP: تحميل الملفات عبر الويب •

FTP: بروتوكول نقل الملفات •

SMTP: نقل الملفات كملحقات بريد •

SMB: مشاركة الملفات في الشبكات المحلية •

TFTP: نقل الملفات البسيط •

NetworkMiner: استخراج الملفات تلقائياً •

Xplico: إعادة بناء بيانات التطبيقات •

Foremost: استرجاع الملفات المحذوفة •

Scalpel: استخراج الملفات من البيانات الثنائية •

Bulk Extractor: تحليل الملفات الكبيرة •

الملفات المشفرة يصعب استرجاعها •

الملفات المضغوطة تحتاج لفك الضغط •

الملفات المجزأة تحتاج لإعادة تجميع •

مشاكل فقدان الحزم أثناء النقل •

قيود قانونية وأخلاقية في الاستخدام •



تحديد الأجهزة المهددة في الشبكة الداخلية
القسم السابع: استخدام Wireshark في الأمن السيبراني

devicesتحليل سلوك الأجهزةwarningمؤشرات الأجهزة المخترقة

computerعاديbug_reportمخترقrouterشبكة

find_in_pageتحليل الاتصالات المشبوهةsecurityإجراءات الاستجابة

مراقبة نمط الاتصالات لكل جهاز •

تحليل البروتوكولات المستخدمة •

مراقبة حجم البيانات المنقولة •

تتبع التوقيتات غير المعتادة •

مقارنة السلوك الحالي بالسلوك الأساسي •

اتصالات مع عناوين IP غريبة •

زيادة حركة المرور بشكل مفاجئ •

استخدام بروتوكولات غير معتادة •

Port Scanning محاولات مسح الشبكة •

اتصالات مع خواديم معروفة ضارة •

MAC فلترة حركة المرور حسب عنوان •

تحليل الجلسات النشطة للجهاز •

فحص البيانات الوصفية للحزم •

مراقبة محاولات الاتصال الفاشلة •

Endpoint Statistics استخدام إحصائيات النهاية •

عزل الجهاز فوراً عن الشبكة •

إجراء فحص شامل للجهاز •

تحديث برامج الحماية والتصحيحات •

مراجعة السجلات والنشاطات •

إعادة الاتصال بالشبكة بعد التأكد من الأمان •



تحليل شبكة منزلية

القسم الثامن: سيناريوهات عملية ودراسات حالة

homeإعداد بيئة الشبكة المنزليةdevices_otherتحليل الأجهزة المتصلة

analyticsتحليل حركة المرورsecurityاكتشاف المشاكل الأمنية

wifi_lockشبكة غير محميةdevicesجهاز غير معروف

توصيل جهاز الكمبيوتر بالشبكة •

تثبيت Wireshark على الجهاز •

تحديد واجهة الشبكة المراد مراقبتها •

Promiscuous Mode تفعيل وضع المراقبة •

التأكد من الصلاحيات اللازمة •

أجهزة أخرىكمبيوتر

استخدام فلتر ARP لاكتشاف الأجهزة •

تحديد عناوين MAC للأجهزة المتصلة •

تعريف نوع الجهاز من خلال العنوان •

مراقبة الجهاز الجديد عند الاتصال •

إنشاء قائمة جرد بالأجهزة الشبكية •

تصنيف البروتوكولات المستخدمة •

تحليل حجم البيانات لكل جهاز •

مراقبة التوقيتات الذروة للاستخدام •

تحديد التطبيقات الأكثر استخداماً •

رصد الاتصالات الخارجية •

كشف الأجهزة غير المصرح بها •

مراقبة محاولات الاختراق •

تحليل الاتصالات المشبوهة •

فحص إعدادات الراوتر والأمان •

تقييم قوة كلمات المرور للشبكة •

راوتر



تحليل شبكة مؤسسة وهمية

القسم الثامن: سيناريوهات عملية ودراسات حالة

businessتصميم بيئة المؤسسة

DMZالخوادمالإدارةالموظفون

trending_upتحليل حركة المرور التجارية

publicتحليل الاتصالات الخارجيةgpp_maybeاكتشاف التهديدات المحتملة

phishingتصيد احتياليdata_usageتسريب بيانات

VLANs تقسيم الشبكة إلى شرائح •

فصل الأقسام عن بعضها •

إنشاء منطقة DMZ للخوادم العامة •

تطبيق سياسات الأمان على جميع المستويات •

نشر أجهزة المراقبة في النقاط الرئيسية •

تصنيف التطبيقات المستخدمة •

تحليل أحجام البيانات بين الأقسام •

مراقبة أوقات الذروة للاستخدام •

تحديد البروتوكولات السائدة •

قياس أداء الشبكة وتحديد الاختناقات •

مراقبة الاتصالات الصادرة للإنترنت •

تحليل الزيارات للمواقع الخارجية •

فحص اتصالات VPN عن بعد •

مراقبة البريد الإلكتروني الخارجي •

تحليل خدمات السحابة المستخدمة •

كشف محاولات الاختراق من الخارج •

مراقبة البيانات الحساسة المنقولة •

تحليل الاتصالات غير المصرح بها •

فحص سلوك الموظفين المشبوه •

تطبيق إجراءات الاستجابة للحوادث •



اكتشاف خرق بيانات داخلي

القسم الثامن: سيناريوهات عملية ودراسات حالة

warningمؤشرات خرق البيانات

trending_upزيادة البياناتaccess_timeنشاط ليلي

find_in_pageتحليل الاتصالات غير المعتادة

person_searchتحديد مصدر الخرقdescriptionتوثيق النتائج

زيادة غير طبيعية في حجم البيانات المنقولة •

اتصالات من خوادم داخلية إلى خارجية •

نشاط غير معتاد في أوقات غير العمل •

استخدام بروتوكولات غير معتادة •

محاولات الوصول لملفات حساسة •

فلترة حركة المرور حسب البروتوكولات •

تحليل الاتجاه غير الطبيعي للبيانات •

فحص المنافذ غير المعروفة •

مراقبة تكرار الاتصالات •

Flow Statistics استخدام إحصائيات التدفق •

تتبع عنوان IP المصدر •

تحليل سلوك المستخدم على الشبكة •

فحص الجهاز المصدر للبرامج الضارة •

مراجعة سجلات النظام والنشاطات •

تحديد طريقة الاختراق المستخدمة •

الاكتشاف
1

التحليل
2

المصدر
3

الاحتواء
4

تسجيل جميع الأدلة الرقمية •

إنشاء تقرير مفصل بالحادث •

توثيق الإجراءات المتخذة •

حفظ ملفات الالتقاط كدليل •

توصيات لتحسين الأمان مستقبلاً •



C2 تحليل برمجيات خبيثة تتصل بخادم

القسم الثامن: سيناريوهات عملية ودراسات حالة

bug_reportتحديد سلوك البرمجيات الخبيثة

syncاتصالات دوريةcodeتعديل السجل

routerC2 تحليل اتصالات

خادم arrow_backC2الجهاز المصاب

fact_checkاستخراج مؤشرات الاختراقsecurityالاستجابة والاحتواء

مراقبة الاتصالات غير المعتادة •

تحليل العمليات المشبوهة •

كشف التغييرات في النظام •

فحص الملفات والعمليات الجديدة •

مراقبة استخدام الموارد غير الطبيعي •

فلترة حركة المرور حسب عناوين IP المشبوهة •

تحليل البروتوكولات المستخدمة في الاتصال •

فحص التشفير والبيانات المخفية •

مراقبة توقيتات الاتصال وتكرارها •

تحليل البيانات المنقولة بين الجهاز والخادم •

C2 للخوادم IP تسجيل عناوين •

تحديد المنافذ المستخدمة في الاتصال •

استخراج البروتوكولات والتقنيات المستخدمة •

تحليل البيانات الوصفية للبرمجيات الخبيثة •

IOCs للكشف إنشاء قائمة مؤشرات •

عزل الجهاز المصاب فوراً •

C2 الخاصة بخوادم IP حظر عناوين •

إجراء فحص شامل للجهاز •

تحديث برامج الحماية والتصحيحات •

مراجعة السياسات الأمنية وتحسينها •



HTTPS تحليل جلسات اتصال مشفرة

القسم الثامن: سيناريوهات عملية ودراسات حالة

httpsTLS/SSL تحليل اتصالات

TLS مصافحةarrow_backتبادل المفاتيحarrow_backبيانات مشفرة

verified_userSSL تحليل شهادات

check_circleصالحةerrorمنتهيةgpp_badمزيفة

vpn_keyمحاولات فك التشفيرanalyticsتحليل التدفقات المشفرة

Handshake TLS فحص مصافحة •

TLS 1.2/1.3 تحليل إصدار البروتوكول •

مراقبة خوارزميات التشفير المستخدمة •

Change Cipher Spec فحص تغيير تشفير •

تحليل البيانات الوصفية للاتصال المشفر •

فحص صلاحية الشهادة وتاريخ انتهائها •

Certificate Authority تحليل جهة الإصدار •

التحقق من سلسلة الشهادات •

كشف الشهادات المزيفة أو غير الموثوقة •

تحليل الخوارزميات المستخدمة في التوقيع •

Key Log استخدام ملفات المفاتيح •

Wireshark استيراد مفاتيح الجلسة في •

محاولة كسر التشفير بالقوة الغاشمة •

استغلال ثغرات البروتوكول •

TLS Proxy TLS استخدام وسيط •

تحليل البيانات الوصفية للتدفقات المشفرة •

مراقبة حجم البيانات ونمط النقل •

تحديد التوقيتات غير الطبيعية •

كشف الاتصالات المتكررة •

Wireshark في TLS استخدام إحصائيات •



مقارنة سلوك الأجهزة في بيئة اختبار
القسم الثامن: سيناريوهات عملية ودراسات حالة

scienceإعداد بيئة الاختبار

جهاز 2مراقبجهاز 1

analyticsتحليل سلوك الأجهزة

find_in_pageاكتشاف الأنماط غير المعتادة

scheduleتوقيتات غير عاديةwarningاتصالات مشبوهة

descriptionتوثيق النتائج

إنشاء شبكة معزولة للاختبار •

تجهيز الأجهزة المراد اختبارها •

تثبيت Wireshark على جهاز المراقبة •

Port Mirroring تكوين المرآب •

تحديد سيناريوهات الاختبار المطلوبة •

مراقبة حركة المرور لكل جهاز •

تحليل البروتوكولات المستخدمة •

قياس أداء الشبكة لكل جهاز •

تسجيل الاستجابات للاستثارات المختلفة •

مقارنة استهلاك الموارد بين الأجهزة •

تحديد الاتصالات غير المتوقعة •

كشف السلوك المتكرر أو غير الطبيعي •

مراقبة التوقيتات غير المعتادة للنشاط •

تحليل البيانات غير المشفرة المرسلة •

مقارنة السلوك الأساسي مع السلوك الحالي •

إنشاء تقارير مفصلة بالاختبارات •

تسجيل جميع الملاحظات والاستنتاجات •

حفظ ملفات الالتقاط كدليل •

إنشاء مقارنات بين الأجهزة المختلفة •

تقديم توصيات لتحسين الأداء والأمان •


